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Copyright Notice
The use and copying of this product is subject to US and International copyright laws.
The Terms and Conditions for use are contained in the Silent Partner, Ltd. Licensing
Agreement.  Any other use is prohibited.  No part of this publication may be reproduced,
transmitted, transcribed, stored in a retrieval system or translated into any language in
any form by any means without the express written consent of Silent Partner, Ltd.
Information in this manual is subject to change without notice and does not represent a
commitment, expressed or implied, on the part of Silent Partner, Ltd.

Federal copyright law permits you to make a backup of this software for archival
purposes only.  Any other duplication of this software, including copies offered through
sale, loan, rental, or gift is a violation of law, and subject to criminal and civil penalties.

Printed in the United States of America.

 2002.  WinSales is a registered trademark of Ascendium Group, Inc and subject to
licensing agreement with Silent Partner, Ltd.  All rights reserved.

Microsoft Windows is a trademark of Microsoft Corporation.

Names of products mentioned herein are used for identification purposes only and may
be copyrighted and/or registered trademarks of their respective owners.

Companies, names and data used in screens, reports, and examples are fictitious.  Any
resemblance to real companies or individuals is purely coincidental.
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About This Manual

This manual is intended as an expansion of the Getting Started With WinSales manual.

The Administrator manual is designed to show you how to:

• Modify the database through the Reference Table and the Administrator program

• Create Remote databases and sites

• Set up security groups

• Adjust User settings

• Customize Workbench Functions – Queries, Reports, Mail Merges, etc

• Use various Word Processing features

• Run the Fulfillment Center program

• Use the Alarm program

• Set up and use Synchronization

• Perform routine maintenance on your database
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Desktop

WinSales Icons On Desktop
You can place any program icon that you have installed on your computer on your
desktop by following the steps below.

Upon installing WinSales, an icon for that program will automatically be placed on your
desktop.  Although you can access the Administrator, Fulfillment Center and Alarm
Programs from within the WinSales program, you may also want to place those icons on
your desktop as well.

 From the Start button select Programs then WinSales.  A list of the WinSales
programs will display.

 Highlight the program you wish to place on your desktop and right mouse click.
 Select “Create Shortcut” from the list.

In the Program list, there will now be a copy of the
program indicated by (2) after the name.

 Click and hold the copy then drag and drop it
onto the desktop.

 Right mouse click the icon and select
Rename.  Highlight and Delete the “(2)” from
the name.
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Reference Tables

Setting Up Your Reference Tables
Reference tables allow you to create drop down lists with more detailed information about
the list items in the table.  An example of this would be a Marketing Campaign you link to
many Contacts and Activities.  You wouldn’t want to keep the details about the Campaign
with each Contact or Activity record.  The details of the Marketing Campaign such as
cost, and type are individual fields stored in the reference table.

In WinSales a field that is a reference to a table has a
magnifying glass symbol adjacent to it as shown here. When
you select an item from the drop down list and double click
on the magnifying glass you are taken to that reference table where you can view details
about that record.

Access the Reference Table
Your WinSales database comes with predefined reference tables.  To view these tables:

 From WinSales choose the View menu and select Reference Material (F6).
WinSales displays the Reference Material window.  The tabs on the right side of the
window represent each table in your database.

You can modify, add and delete the fields of information in the reference tables through
the Administrator program.  The file folder symbol adjacent to Activity and field names
indicate the items this Table is linked to.  You can modify, add and delete these links
through the Administrator program.

Campaign Reference tab is shown above.
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Reference Table Tabs
Area Code –  Telephone area codes may be entered with a note indicating the related
State.  Because this information is constantly changing it is your choice whether to
maintain this list.  No records have been entered into the program.

Campaign – Sample Campaigns have been entered in the Training Database.  To view
them, from a clear window select Find and use the Scroll Buttons.  See detailed
instructions about Campaigns later in this manual.

Competition – Allows entry of details about your competitors for easy reference.

Marketing Details – Detail of the items that make up your marketing campaigns
(magazine ad, tradeshow, etc.)

Product – All items you sell, and/or services you provide, with a field for the price.

Sales Rep – A record for each of the sales reps in your database.

State – Keeps track of the postal code for each state.  This table has already been setup
for you.

Find An Existing Record
 Choose the tab corresponding to the table being searched.
 If a record is displayed on the tab, choose the Clear button at the bottom of the

screen.
 CLICK in the field you wish to search on.
 Enter the value to search for.

Note:  WinSales searches for records whose data begins with the value you enter here.
For example, if you enter a campaign name of "Tele", WinSales returns all campaigns
whose name begins with "Tele".  To conduct exact-match searches, use the Workbench.
Leaving all the fields blank on the tab and choosing Find will return all records.  Use the

 and  buttons in the lower left corner to scroll through the records.

Add A New Record
 Choose the tab corresponding to the type of record being added.
 If a record is displayed on the tab, choose the CLEAR button at the bottom of the

screen.
 Click the NEW button.  You can use your mouse or the “tab” key to move forward

through the fields on the tab, and SHIFT+TAB to move backward through the
fields.

 Enter information in the blank fields.
 Enter notes, if desired, in the note area to the right of the data entry area.
 Choose the SAVE button at the bottom of the screen.
 Repeat steps 3 and 4 for each record you would like to add to the table.
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Modify A Record
 Choose the tab corresponding to the type of record being changed.
 If a record you wish to update is not displayed, choose the Clear button at the

bottom of the screen.
 Find the record you wish to modify. See To find an existing record, above.
 Make changes in any of the fields on the record.
 Change notes, if desired, in the note area to the right of the data entry area.
 Click the SAVE button at the bottom of the screen when finished.

Delete A Record
 Find the record that you wish to delete.
 From the Edit menu choose Record and Remove or press CTRL+R.
 Choose the Yes button on the subsequent dialog to verify the delete.

Note:  WinSales will not permit a record in a reference table to be deleted if records in
other reference tables or activities refer to it. You will need to find all records that contain
links to that reference table item and change them to another value before WinSales will
allow you to delete them. HINT: You can enter a “z” in front of the name and it will drop to
the bottom of the list. This makse your  list more manageable without loosing the data.

Add/Modify/Delete Fields In A Table
Use the WinSales Administrator program to modify fields in any of the reference tables.
Refer to the Administrator Section in this manual for details.

Add A New Reference Table
Use the WinSales Administrator program to add a new reference table.  Refer to the
Administrator Section in this manual for details.
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Search For Activities/Contacts Linked To A Reference Table
If you want to find all the records that are linked to a record in a reference table you can
do that in three ways, and in three different areas of WinSales.

Method One (easiest)
 From the Reference Table (F6) click the tab you wish to search on.
 Find the desired record by following the instructions in ‘Find An Existing Record’,

above.
 Below the simple fields on the tab are File Folder symbols that represent the links

to the activities and tables that use this reference table.
 DOUBLE CLICK on the File Folder for the activity or table you wish to find records

for.
Example - On the Campaign tab, enter Website in the Name field then double
click the file folder adjacent to “Contact” to find how many Contacts were entered
into the database as a result of that Campaign.

The Message Panel will display the number of records found.

 Use the Scroll Buttons to advance through the records.

Note - The file folder symbols mentioned above represent the links to multiple activities
and tables that the WinSales Workbench uses to search spanning contact, reference
tables, and activities.

Method Two
In the Workbench you can create a Query to find all Phone Call activities that are linked
to a particular Sales Rep (for example).  When using a Query your search results will be
in a grid format with the fields you selected.  You can then DOUBLE CLICK any record in
the grid and the system will display that record in the WinSales window.  See the
Workbench Section in this manaul for details on how to build a Query.

Method Three
If you are searching for information regarding Sales Reps or Campaigns on Activities you
can use the Activity Log Filter.  See the Activity Log Filter section in the Getting Started
manual for details.
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Managing Reference Table Drop Down Lists
A reference table can accumulate many records, some of which may become obsolete
over time.  There are two schools of thought on how to maintain drop down lists.

One – Delete the record thereby losing all history connected with it.

Two – Drop the record to the bottom of the list by typing a small case letter z in front of
it.  Example:  Marketing Details Table

 Select the Table you wish to modify.
 Find the Record you

wish to modify in the
Name field.

 Place your cursor in
front of the name and
type a lower case “z”.

 Click SAVE.
The drop down list of your Marketing Details field will now look like this:

Campaigns And Marketing DetailsWhat Are Campaigns and
Marketing Details?
Campaigns and their associated Marketing Details are Reference Table items.
Campaigns are marketing projects for which you wish to measure performance.

Example: You create a Campaign called Magazine.  You run ads in New York
Magazine, Newsweek and Airline Weekly.  Each of these publications is a Marketing
Detail.  Refer to the Reference Table (F6) tabs for examples.

Why Track Campaigns?
Campaigns enable you to track the effectiveness of marketing projects within your
organization. Properly used the Campaign and Marketing Details will allow you to see
which Campaigns were affective and which specific media used for the campaign work
best.
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Campaign Fields
The Initial Mkt Campaign field (shown below on the Contact window) is a reference to
the Campaign table and lists all of the marketing campaigns you work with. This field
tracks the Campaign that brought the Contact to your business.  DOUBLE CLICK an item in
the list to view details in the Reference Table.

Marketing Fields
The Marketing Details field (shown below on the Contact window) is a reference to the
Marketing Details table.   This is a list of all the specific advertisements and marketing
vehicles you use in your marketing campaigns.  DOUBLE CLICK an item in the list to view
details in the Reference Table.
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Link Campaigns and Marketing Details
 Set up a Campaign in the Reference Table (F6).  See “Add A New Record” in the

Reference Table section in this manual.
 Choose the Marketing Details tab (shown below) and add a new record in the

same way.
 Choose the Campaign this will be linked to in the Associated Campaign field.

Campaigns And Activities
When a User enters a new Contact they are asked to select the Marketing Details in the
Contact input wizard. The Campaign associated with the Marketing Details is
automatically populated as the Initial Mkt Campaign on the Contact window.  That
Marketing Detail and Campaign are automatically assigned to all Activities associated
with this Contact until they are changed.

When working with Activities you are asked to select a Marketing Detail for each Activity
in the database.  When you change the Marketing Details, this new value will be
associated with all future Activities with that Contact until you change it again.  This gives
you the ability to track what Contacts are responding to by Campaign and Marketing
Detail.
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Campaigns And Action Plans
To link a Campaign to an Action Plan you must first create the Campaign and Action
Plan.  See Add A New Record in the Reference Table section in this manual.  See the
Action Plan section in the Getting Started manual.

 In the Action Plan definition area (WinSales Options menu - Action Plan) select
the first step of the Action Plan and choose the Activity Template button.

 On the Activity Template window select the Campaign and Marketing Details
fields and choose the values you want linked to this Action Plan.  Click SAVE.

When a Contact is initiated on the Action Plan, all subsequent Activities will be linked to
the same Campaign until a User logs an Activity and selects a different Campaign.

Measuring A Campaign's Value
All Contacts and Activities in your database are linked to a Campaign.  Over time
managers are able to evaluate the effectiveness of Campaigns to see how many new
Contacts were entered into the database, sales were generated or calls were made as a
result of a particular Campaign.  Your database comes with predefined Queries and
Reports to help measure your Campaigns.  You may modify these existing queries and
reports or build your own to suit your needs using the Workbench.  See the section on
Building Queries and Reports in this manual.

Campaign Activity Wizard
There is a WinSales User Wizard
called Export Activity Data by
Campaign which creates a CSV file
that can be opened in Microsoft
Excel with all the Activity data
associated with a selected
Campaign.  This file can be used as
a data source for products like
Crystal Reports to create summary
reports on overall activity data for
marketing campaigns.  See the section on WinSales User Help Wizards in this manual
for details.
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Word Processing

In order for WinSales and Microsoft Word to work together and merge data, paths are
established on each workstation to connect the two programs.  These paths are
automatically set for you upon installing WinSales to the default C drive.  If you redirect
WinSales to another location in Microsoft Explorer you will need to set new paths.

How It Works
When you DOUBLE CLICK the letter icon in the Correspondence Activity tab in WinSales or
highlight a document in the Fulfillment Center and click Merge, you are asking the
program to open Microsoft Word and merge WinSales data into the selected document if
merge fields are a part of the document.

1. WinSales looks for Microsoft Word and opens it.

2. WinSales looks in Explorer for the letter you selected and opens it in Word.

3. WinSales looks for the Header File (the list of WinSales merge fields) and opens
it so the data for the merge fields in the document can be retrieved from the
database and inserted into the document.

4. Microsoft Word pulls the merge field data out of the Contact window and puts it
into the document via the Header file.

Set Up
To successfully merge WinSales data into Microsoft Word documents four things must be
in place.

One – You must have Microsoft Word installed.

Two – You must know where the WinSales program files are located in Microsoft
Explorer.  These program files include the Letters file and the WinSales Header file.
They are defaulted to C/Program Files/WinSales upon installing the program.  See below.
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Three – You must have pre-written letters or letter templates that have WinSales merge
fields in the WinSales Letters folder.  The WinSales program comes with mergeable letter
templates in the Letters folder that you can modify and save.  DOUBLE CLICK the Letters
folder shown in the WinSales directory above.

Four – You must establish the User Setting on each workstation that will locate
Microsoft Word and the WinSales Letters and Header Files in Microsoft Explorer.  This is
referred to as the “path”.  This path is pre-set if you installed WinSales to the default C
drive in Explorer.  See the illustration below.

Word Path Settings
 From the WinSales menu choose Options then Modify then User Settings then

the Word Processing tab.
This illustration shows the automatic default settings.

FormLetterPath tells WinSales where the letters directory is located in Microsoft
Explorer.  See illustration below.
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FormLetterHeader tells WinSales where the Header File is located.  The Header File
is the string of WinSales merge fields that must be attached to documents you wish to
merge with WinSales elements.  These fields are separated (delimited) by a comma (,).
See illustration below.

FormLetterLocalPath tells WinSales where the letters directory is located on each
individual workstation.  If you are on a network, it is a good idea for everyone to be
connected to the same directory so as not to have duplicate letter files.  This makes it
easy to update letters in one place.

The illustration below shows a document template with WinSales merge fields and the
drop-down list of those fields which are the same as the items in the Header File.
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Create A New Merge Document - From An Existing One
Recommended Method

A merge document can be a letter, label, envelope, postcard, etc.  Because this program
comes with prewritten merge letter, label and envelope templates, it is recommended that
you open a template or other existing document and simply customize it.  You can then
SAVE AS a new document name in your letters directory.

 Go into Explorer to your letters directory and make a copy of an existing
document.  (Ctrl + C then Ctrl + V makes a copy that will appear at the bottom of
your letters list).

 Open the letter and delete everything you don't need then add your new text.
 Add new merge fields from the "Insert Merge Field" button on the toolbar.
 Make any other adjustments you need to the document (margins,etc),
 From File select SAVE As and rename it.
 Add it to the Correspondence drop down list through the Administrator if you

want to.

Create A New Merge Document - From Scratch
Alternate Method

If you are running a version of Word other than 2000, these instructions may
differ slightly.  Use Microsoft Word’s Help feature for instructions.

Step 1: Create the main document
 Open Microsoft Word to a blank document.
 From the menu bar select Tools then Mail Merge.
 1 - Main document, click Create, then click a document type.
 Click Active Window.  The active document becomes the main document.

Step 2: Open or create the data source
In the Mail Merge Helper dialog box, do the following:

 2 - Data source, click Get Data, then click Header Options - Open.
 In the Explorer window path to:  C/Program Files/WinSales.
 In the “Files of Type” field on the bottom of the window, select “All Files” *-*.
 Highlight and open the “WinSales.hdr” file.
 In the Field Delimiter drop-down list, (Tab) is highlighted, but select (,) comma,

which is the choice directly below it, then click OK.
 Close the Mail Merge Helper window.
 Your document should now have an “Insert Merge Field” button on the Toolbar.

Step 3: If you are creating a Label:
 If you don't see the Label Options dialog box, click anywhere in the main

document, and then click Mail Merge on the Tools menu.
 Under Main document, click Setup.
 Select the type of printer and labels you want to use, and then click OK.
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If the type of labels that you want to use is not listed in the Product number box, you
might be able to use one of the listed labels, or you can create your own.

 In the Create Labels dialog box, insert merge fields where you want to merge
addresses from the data source.

 To insert a merge field, click Insert Merge Field, and then click the field name
you want.

 If you want to include POSTNET bar codes on mailing labels, click Insert Postal
Bar Code. Specify the merge fields that contain the ZIP Code and street
address, and then click OK.

 Click OK.

Step 4: Save the Template in WinSales
 Select “Save As” from the File menu and type the name of your new document.
 Add it to the Letter drop down list in the Correspondence tab through

Administrator.  See Instructions Below.

Add A Letter To The Drop-Down List
When you want a letter template to appear in the drop-down list for Correspondence
activities it is done in the Administrator program.

 From the WinSales menu select Tools then Administrator and log in.
 In the Activities/Tables list select Correspondence and click Elements.
 In the Elements list select Letter and click Details.

 In the Define a Field window press the “Has Valid Response List” button.
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 In the Response field, type the name of your new letter exactly as it appears in
the Letters directory in Explorer.  It may be easier to cut and paste it.  Select
SAVE.

 You will notice the new letter name as been added to the Responses list in
alphabetical order.

 Click  Done on all Administrator windows to close them.

 To see the change in the Correspondence tab, log out of WinSales then log back
in.

 Open the Correspondence
activity tab, click on the
Letter field and view the
drop-down list.

Troubleshooting Merge Letters
The most common problems that arise when merging WinSales elements with Microsoft
Word documents are:

• Problem:  The WinSales Header File becomes detached from a document so
the merge field data cannot be found.  Solution:  Reattach the Header file.

• Problem:  You install a new version of Microsoft Windows and/or Word and the
letters no longer merge.  Solution:  Convert the letters to the new Word version.

• Problem:  Microsoft Word gets relocated in Explorer due to installing other
programs.  Solution:  Reset the path in the User Settings to the new location.

These and other solutions can be found on our website at www.winsales.com.  Select
Support to see a variety of documents for troubleshooting Microsoft Word and Mail Merge
problems.
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The WINSALES.HDR fileThe WinSales Header file is attached to each of your
Microsoft Word documents allowing you to process merges from WinSales.  Each User
has a User Setting in WinSales called the FormLetterHeader (see above) where the
User’s HDR file for word processing is designated.  Normally this setting is set to
C:\WINSALES\WINSALES.HDR.  Since the HDR file cannot be shared by Microsoft
Word, Users cannot be mapped to the same file on a network.

You may only merge information from the Contact window.  You can add any field on the
Contact window to the WINSALES.HDR file by adding that field's column heading to the
WINSALES.HDR.  The way this process works is when you merge a document the fields
in your WINSALES.HDR for the Contact(s) selected are put in a temporary file that acts
as the data source for your merge with MS Word.

Note - Any inconsistency in the column headings in your WinSales database with
the fields in the WINSALES.HDR and your form letter will cause MS Word to
error out when processing the merges.

Tips about the WINSALES.HDR
You can only have 100 fields in the WINSALES.HDR.  If you need to use more then 100
fields in a merge you will need to create a second HDR file.

When creating new fields on the contact screen do not put spaces in the column
headings.  Spaces can cause problems if you choose to add the field to the
WINSALES.HDR for merges.  Do not start column headings with numbers or symbols,
again they will cause problems with Word in the merge.

Modifying the WINSALES.HDR
When adding a merge field to the WINSALES.HDR file, open the file in Notepad.  It is
located in your C:\winsales directory.

Upon first installation the WINSALES.HDR looks like this:

"Date","Company","Honorific","First","Last","Street1","Street2","City","State","Zip","Countr
y","SalesRep","Phone","Fax","EMail"

If you want to add a new field simply go to the end of the line and type ,”Salutation” (for
example), to add the salutation field to the list of fields you can use in a merge.  Do not
put any carriage returns in the WINSALES.HDR, just let your typing wrap around to the
next line.

Now when you open the form letters in Microsoft Word and click on the Insert Merge
Field button you will have the Salutation field available as a merge field in your document.
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Email

Anywhere in WinSales that you can interface with your Word Processor to create a form
letter, you can also create an e-mail to be sent using your MAPI-compliant e-mail system.
If you are using a MAPI-compliant e-mail system (MS Outlook, Exchange and Mail, or
other vendor’s MAPI compliant versions like Eudora and Groupwise), you may transmit e-
mail messages as simply as you can print a letter.

If you do not have a MAPI-compliant e-mail system you cannot use these
features in WinSales.  Outlook Express is not MAPI compliant!!

How It Works
Once your WinSales User Settings are modified to use email and a text (.txt) version of
your document has been created, the system will send correspondence via email when
the Method of delivery selected is Email and if the Contact has an email address in the
Email field on the Contact window.  For those Contacts with NO EMAIL ADDRESS, your
Word Processor will merge the document to be printed and mailed.  The following items
show you how to get everything in place.

Email User Settings
WinSales uses several User Settings to process and send email.  User settings are User
specific so wherever you log, in your settings follow you.  Each setting you need for email
use is detailed below:

UseEmail Setting
When working in WinSales this setting tells the program to use email when requested.

 In WinSales select Options – Modify – User Settings.
 Select the General tab, and choose the setting, "UseEMail" and change the 0 to

1 in the New Setting field.
 Press SAVE.
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Email Address Field Setting
This tells WinSales which field stores the Contact’s email address.

 In WinSales select Options – Modify – User Settings.
 Select the Contact tab, and choose the setting, "EMailAddressAttribute"
 Click on the New Setting drop down list and select the E-Mail field from the list.
 Press SAVE.

Activity Method Field
On the Correspondence Activity tab there is a field to indicate the Method for sending a
letter.  Email must be one of the choices in the list.  If you have multiple activities that
contain Letter fields, create a Method field for each of them using the WinSales
Administrator.

 In WinSales select Options – Modify – User Setting.
 Choose the Word Processing tab and select the setting EmailMethodField.
 Click on the New Setting drop down list and select the Method field.
 Press SAVE.

Method Setting
WinSales will look at the Method field and determine if the letter should be sent through
an email.

 In WinSales select Options – Modify – User Setting.
 Choose the Word Processing tab and select the setting EMailMethodValue
 Click on the New Setting drop down list and select Email.
 Press SAVE.

When you attempt to merge a document WinSales will check the activity to determine if
the letter should be emailed.
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Subject Setting
On the Correspondence Activity tab there is a field to indicate the Subject heading of the
email.  This text will appear on the recipient’s email Subject line.

 In WinSales select Options – Modify – User Setting.
 Choose the Word Processing tab and select the setting EmailSubjectField.
 Click on the New Setting drop down list and select the Subject field.
 Press SAVE.

If you have multiple activities that contain form letter fields, create a field called "Subject"
for each of them.

Attachment Setting
On the Correspondence Activity tab there is a field called Attachment for the form letter
path to the file that is to be attached to the email.

 In WinSales select Options – Modify – User Setting.
 Choose the Word Processing tab and select the setting EMailAttachField
 Click on the New Setting drop down list and select the Attachment field.
 Press SAVE.

Note:  When you enter the file you wish to attach to this email be sure you
include the full directory path for the file in the Attachment field.  If you have
multiple activities that contain form letter fields, create an "Attachment" field for
each of them.
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Set the Merge Delimiters
Be sure the "EmailMergeDelimiters" setting is established as it should be when WinSales
is installed.

 In WinSales select Options – Modify – User Setting.
 Choose the Word Processing tab and select the setting "EMailMergeDelimiters".
 Click on New Setting and enter the value 171,187.
 Press SAVE.

Create/Convert A Document For Email Use
There must be a Text (*.txt) as well as a Word Document (*.doc) version of the document
being sent.  This is so you can print and mail the document to Contacts who do not have
email addresses.

Once you have created the Word Document you can easily convert it or any other
existing Microsoft Word form letter into a format usable by the email system.

 Open Microsoft Word.
 Select File + Open and navigate to the location your Word document.
 Highlight it and make a copy by either right mouse clicking and choosing Copy

then right mouse clicking again and choosing Paste or by highlighting it and
pressing Ctrl+C then Ctrl+V.

 Open the copy of the document  and choose Save As from the File menu in
Word.

 In the "Save as Type" drop-down, choose "Text Only with Line Breaks".

 Change the “File name:” by deleting the words, “Copy of” from the document
name.  Press SAVE.
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A message window will display telling you that the format of the document may change.

 Press YES.

This is the Word Document version:

This is the Text version:



30

Your Letter directory will now look like this:

It's always a good idea to experiment with your form letters before performing a mass
mail function via email.  Test out your email letter by sending one to an associate, or
yourself first.  If you want to make changes to the format of the letter open the TXT file in
Notepad and modify it.  The body of the TXT letter and the form letter
(DOC) can be different.

Sending Email From WinSales
In WinSales just as you merge a letter, you can send an email by going to the activity
where you process merges and set an activity up with the Method of email and then
select the DOC letter name.  When you double click to merge the letter it will see the
method is email and the Contact criteria for sending mail has been met, WinSales will
send the TXT file for that letter to the Contact.  If you schedule and save this activity you
can do the same thing from Fulfillment Center.  Most users are looking to build an Action
Plan that has the Correspondence activities set up to send email with letter, subjects, and
attachments defined, then Mass Assign a group of contact using the Workbench to
schedule the Correspondence activities for Fulfillment Center to email or print for mailing.
When you select a group of cells to merge in Fulfillment Center, WinSales will either
email or merge the letter to Word depending on whether the Contact meets the
parameters established above.

One final thing to keep in mind when sending email from WinSales or Fulfillment Center
the email is going out to contact from the profile you are logged into your email software
as.  That is likely the address contacts will reply to.  Make sure before you send your
emails out you are logged into the email software as the profile you want the
emails to be from.

For more information on sending email from WinSales see SUP033.DOC and
SUP034.DOC on our WWW site at: http://www.winsales.com/support.htm
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Workbench

The Workbench is a tool that will allow you to use the information in your database in a
variety of ways.  This section will show you how to build your own custom Workbench
functions.  Refer to your Getting Started With WinSales manual for an overview of the
Workbench and use of pre-defined Workbench functions.

Print Workbench Results

Queries The data is displayed on your screen and can be printed by
selecting Print from the File menu in WinSales.

Reports The report is automatically printed when you click Results.

Export No printing is performed.

Mass Assign No printing is performed.

Mail Merge The letters may be printed automatically (depending on how the
mail merge was designed).  We recommend you merge to
Microsoft Word and print the letters there after reviewing the
results.

- Simple Queries

What is a Query
A query is used to search for records in your WinSales database.  A query is required
when you need a search condition other than Equal To, to use more than one window for
your search, or if you wish to view search results in a grid.

Create A New Query

Plan Your Query
Before building your query, work through the following steps:

 Decide what you want the system to search the database for (Criteria Tab)
 Decide the order in which you want the information displayed (Sort Order Tab)
 Decide what fields of information you want to display (Fields Tab)

Sample Query: Find all of Janet Evergreen’s Contacts that have a Relationship of
“Prospect-Cool (Criteria) listed by the Contact’s last name (Sort Order) and display
their first name, last name, phone number and Sales Rep name in the results grid
(Fields).

 Determine which window contains the Criteria data that you wish to find.
In the Sample Query above, the criteria fields we are seeking (Contacts, Relationship,
Sales Rep) are found on the Contact Window.

Remember WinSales is a relational database so you can start your query from
any Activity or Table.



32

Create the Query
 From WinSales open the Workbench from the View menu or press F4.
 Click the + adjacent to Query and highlight [New Query].
 Click the Criteria Tab

Criteria Tab
The Criteria is what you want the system to search for.  The Criteria Table is divided into
three sections.

Make a Choice is a list of the Tables and Activities to begin a search on.  When a
selection is made, the fields contained within that choice display in the order they appear
in the WinSales windows.  You can then choose the fields of information you want to
search for and display in the Query results.  Example:

 If you are searching for Contact information, select Contact.
 If you are searching for Phone call activity, select Phone Call.

Condition is used to set “Conditions” for the field you selected in the Make A Choice
section.  The drop-down field above the word “Condition” can contain a list of choices
(such as Sales Rep field) or you can type an entry (such as State).  “Equals” is the
default condition but you can select other options depending on the search.  See
“Complex Queries” for details.

Selection displays the choices that have been made to build your query.
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To Build Our Sample Query:
 Click Contact in the Make A Choice section.

The Contact fields will display in the order they
appear in the Contact Window.

 Highlight the Sales Rep field in the
Make a Choice section.

Because Sales Rep is a field with a drop-down list, you must set a Condition of which
Rep you want.

 Click the  on the drop-down field above the word Condition and select
Janet Evergreen.

 Click the Add button that has become bold at the bottom of the Condition
section.
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 Highlight the Relationship field in the Make A Choice section
 Select Prospect-Cool from the Condition drop-down list
 Click Add at the bottom of the Condition section

Notice that the Selection section has been populated with the choices that were made
and is creating the “story problem” we formulated before beginning the Query.

 When you are finished building your criteria, click on the Sort Order tab.

Sort Order Tab
The Sort Order tab allows you to sequence the search results.  By selecting the Sort
Order tab, the system has inserted a heading of “order by” in the Selection section.

 From the Make a Choice list, click on the field(s) you wish to use to sort the
results, then click the ADD button.  In this example select the Last Name field.
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Additional sort fields can be added in the same way.

 Use the up/down arrows, located above the Selection area, to rearrange the sort
fields by highlighting the field and clicking the appropriate arrow.

Remove A Field From The Selection Section
 Highlight the field and click the Remove button that has become bold.
 When finished select the Fields tab.

Fields Tab
The Fields tab allows you to select the fields you wish to display in the results grid.
The Criteria you selected will not automatically display.  Criteria is only
used to search the database.  By selecting the Field tab, the system inserts a
heading of “include fields” in the Selection section.

 From the Make a Choice list, click on a field you wish to include and click the
ADD button.

 OR DOUBLE CLICK the field.
 Add additional fields in the same way.
 For our example select First Name, Last Name, Phone, Sales Rep and Date

Entered.  Remember – These fields appear in the list in the same order
they appear in the WinSales window.

 Use the up/down arrows, located above the Selection section, to rearrange the
fields in the order you want them to appear in the results grid by highlighting the
field and clicking the appropriate arrow.
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Results Tab
The Results tab allows you to view the results of your query in a grid.  The message
panel will display the number or records found.  You may DOUBLE CLICK on any value in
the grid and the system will open the record in the WinSales database.

Modify A Query
If the Results are not what you expected or the message panel displays, “No Matching
Data Found”, you can easily modify the query.

 Select the Criteria tab if you want to change the search information.
 Select the Sort Order tab if you want to change the order of the results.
 Select the Fields tab if you want to change the fields displayed on the results

grid.
 Highlight an item in the Selection section then click the Modify button at the

bottom of the Condition section.  Make a new choice and click ADD.
OR

 Highlight an item in the Selection section then click the Remove button at the
bottom of the Condition section.

OR

 Highlight an item in the Selection section then re-arrange the order it appears in
the list by clicking the appropriate arrow on either side of the word Selection.

 Be sure to SAVE the change if the Query had previously been saved.

Save A Query
If you are going to use a Query more than once you can save it the Use tab list.  When
you have finished building your Query:

 From the Criteria tab click the SAVE function key at
the bottom of your screen.

 Enter a name in the blank field above the Query list.
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 Select a Security Option.  “For Public Use” will default so anyone can see
and access the Query.  “For Private Use” will allow only the Query builder to
see it in the Query list.

 Trigger use with Queries is rare and complicated.  Leave this field blank.
 Click OK.

Print Query Results
 From the Results tab select File – Print from the WinSales menu bar.

Delete A Query
 From the Workbench Use tab highlight the Query you wish to delete from the list
 From the WinSales menu bar select Edit – Record – Remove this Query.
 When asked if you’re sure you want to delete the Query select Yes.
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-Complex Queries
As the complexity and sophistication of your data grows, the requirement to access it with
more than a simple search also grows.  For that reason, you may use Conditions in a
variety of ways.

Condition Uses

Equal   This is the default.  It searches for data equal to the selected criteria.  You can
make more than one selection per field.  FOR EXAMPLE: Find Meetings for Sales Rep’s
John and Sue.  Select one name at a time from the drop-down list and click ADD.  If the
Make a Choice field does not have a drop-down list, type your criteria in the Condition
field and click ADD.

Less  Searches for data less than the selected criteria.  FOR EXAMPLE:  Find Sales
under $100,000.00.  After selecting the Sale Amount field in Make a Choice, click the
Less Condition button, type the amount in the Condition field then click ADD.

Less/Equal  Searches for data less than or equal to the selected criteria.  Follow the
example for LESS above.

More/Equal  Searches for data more than or equal to the selected criteria.  Follow the
example for LESS above.

More  Searches for data more than the selected criteria.  Follow the example for LESS
above.
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One Of  Searches for data included in a list of selected criteria.  Example:  Find all
Contacts in the States of Arizona, Colorado and New Mexico.  After selecting the State
field under Contacts in the Make a Choice section, click the One Of button then type the
State’s abbreviation’s in the Condition field.  Click ADD after each entry.

Between  Searches for data between the selection criteria.  Two values may be entered
into the Condition field.  This could be a date range or dollar amount  Example:  Find
Sales for the month of July that were between $250,000 and $500,000.  After selecting
Sale then the Date field from the Make a Choice section, click the Between Condition
button and enter 7/1/2001,7/31/2001 in the Condition field and click ADD.  Next, highlight
the Sale Amount field in the Make a Choice section, click the Between button and
enter 250000,500000 in the Condition field.

Is Like  Searches for data that starts with the selected criteria.

Not  Searches for everything but the selected criteria

More Criteria Features
When adding search criteria, instead of entering a value you may enter any of these
special @ statements, or use the @ask feature with any field in your database:

Value Description
@today Uses today's date.
@tomorrow Uses tomorrow's date.
@yesterday Uses yesterday's date.
@first Uses the first day of the current month.
@last Uses the last day of the current month.
@ask(question) Prompts for a value to use when the  query is run. Displays

question, the user enters a response, and the response is used
as the value.
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Queries That Ask Questions – Who, What & When?
You can build a Query that will allow you to enter dates, date ranges and make selections
from drop-down lists using the @ask(question) feature described above.  The examples
below are just a few of the many scenarios this function can be used for.

Examples:

• Single Date - Find Contacts entered into the database on March 10, 2002.

• Date Range - Find all Resolved Sales in the month of March.

• Display A Drop-Down List – Find Scheduled Phone Calls by Rep Name.

• Combinations – Find Contacts who were sent a specific letter on a specific
date.

Single Date
Find Contacts entered into the database on March 10, 2002.

 Select Contact from the Make A Choice list.
 Select the Entered Date field from the Make A Choice list.
 Leave the Condition button on the default of Equal.
 In the Condition field type @ask(Date Entered) then press the Add button.
 Complete the rest of your Query as normal and save it if you like.

When you click the Results tab or DOUBLE CLICK the Query in the list to run it, a window
will display asking for the date you are looking for.

 Enter a date in the field and press OK.
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Date Range
Find all Resolved Sales in the month of March.

 Select Sales from the Make A Choice list.
 Select the Date field then click the Condition of Between.
 In the Condition field, type @ask(Start Date) then click the Add button.
 In the Condition field, type @ask(End Date) then click the Add button.
 Complete the rest of your Query as normal and save it if you like.

The Selection window will look like this:

When you click the Results tab or DOUBLE CLICK the Query in the list to run it, a window
will display asking for the dates you are looking for.

Enter a date in each field and press OK.
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Display A Drop-Down List
Find Scheduled Phone Calls by Rep Name.

 Select Phone Call from the Make A Choice list.
 Select the Sales Rep field then click the Condition of Equals.
 In the Condition field, type @ask(Select Rep) then click the Add button.
 Complete the rest of your Query as normal and save it if you like.

The Selection window will look like this:

When you click the Results tab or DOUBLE CLICK the Query in the list to run it, a window
will display asking for the Rep you are looking for.

Make a selection from the drop-down list and press OK.
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Combinations
Find Contacts who were sent a specific letter on a specific date.

 Select Correspondence from the Make A Choice list.
 Select the Letter field then click the Condition of Equals.
 In the Condition field, type @ask(Choose Letter) then click the Add button.

 Select Date from the Make A Choice list.
 Select the Condition of Equals, type @ask(Enter Date) in the Condition

field then select the Add button.
 Complete the rest of your Query as normal and save it if you like.

The Selection window will look like this:

When you click the Results tab or DOUBLE CLICK
the Query in the list to run it, a window will display
asking for the Rep you are looking for.

 Make a selection from the drop-down list
and press OK.
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Search for null values (blank fields)
In WinSales it is normally not possible to search for null values, but we have found
several scenarios where that rule does not apply, and the Workbench is able to search
for null values.  In the top ten fields on the Contact window it is possible to search for a
space, or blank (for example contacts with no phone number).  This functionality is also
possible in the top six fields of the activities (where you could, for example search for
Phone Calls with no date.).  In other areas of WinSales we are restricted by database
design from searching for null values.

Copy Query Results
When working with a Query the results may be copied to the Windows clipboard for use
in other applications such as Excel.  To copy data from the Query grid to Excel highlight
the portion of the grid that you would like to copy.  Right mouse click and select Copy (or
Ctrl + C).  Then open Excel and select that top corner record and  right mouse click and
select Paste (or Ctrl + V), and the results are pasted into an Excel spreadsheet for further
review.

-Reports
Custom Reports are built the same as Queries execpt they allow you to design the layout
of the printed results.

Plan Your Report
Plan your report the same way you plan a Query.

 Select the Criteria, Sort Order and the Fields you would like to include in
your report.

Below is an example of a pre-defined Report that asks for a Rep’s scheduled phone calls
in a specified date range.
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Report Layout
 Click the Layout tab.

This page is divided into sections including:  the page margins, the title section (prints at
the top of each page), the column heading section (prints at the top of each page), and
the detail section (one line for each record or record group).

Moving Elements
Any report element that appears in a box may be moved in its current section by clicking
on the box, holding the mouse down, and dragging.

Element Definition
To view or change an element, click on it to select it from the element list.  The element
definition includes:  column heading, display mask (numeric or date fields only), height
and width, top and left, align (left, center, or right), print, font, and color.

How Often and Where to Print
Print determines how often and where an element prints on the report.  Once per detail:
print in the detail section on each line.

Once per instance: Prints in the detail section, but only the first time a different value
occurs in the field.

Once per page:  Prints in the title section.

Inserting Elements
You may insert system-maintained elements including date, time, and page number.  To
do so, choose Date, Time, or Page Number from the Insert menu.  These elements
appear in the list surrounded by square brackets.  You may insert text into the body of
your report.  To do so, choose Text from the Insert menu.  Type in the text and click OK.
These elements appear in the list as entered.
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The Options Menu
To remove a report element, select it from the list, and choose Delete Element.

To include the associated notes in the report (centered under each line), choose Include
Notes.  Remember the notes come from the table you started your report from (Find
Contacts for instance).

 To automatically align elements when moved, choose Auto Align.
 To adjust section sizes, choose Set Area Sizes.

Saving a Report
Choose Save As from the Report menu.  You are prompted for a name.  You may either
select an existing report and overwrite it, or type in a new name.

Printing a Report
Choose Printer Setup from the Report menu to select a printer and print options, then
choose Print from the File menu.  You may also click the Results tab.

Run an Existing Report
Once a report is defined and saved, it appears under the list of existing reports on the
Use tab.  To run an existing report, click on it in the list to select it, then click the Results
tab.

Refine a Report
Open an existing report by selecting it from the list of existing reports.  You may add to,
change, or delete from the existing report definition.  To save the changes, choose Save
As from the Report menu in the Layout tab and either overwrite the existing report or
assign a new name to create a new report.

Create Group Sections
Group sections are defined by the sort fields you select for a report.  These sections are
floating sections.  When one "group" of records ends, a floating group section is inserted
in the body of your report.

Example:  Use the Sale and Sales Rep windows to create a Sales report.  Sort (group) by
Sales Rep Name.  Include Sales Rep Name, Date, and Amount.

Accumulate Fields
You may accumulate a numeric field in WinSales to display totals in the group sections.
To do so, select the element you wish to sum in the element list of the Layout window,
then click an entry from the accumulate box in the upper right-hand corner.  If you choose
Grand Total, WinSales creates totals in all group sections.  If you choose group 1,
WinSales creates totals in all group sections except the grand total section.

Example:  Accumulate Amount and display totals in all
group sections.
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- Exports

What is an Export?
You may use data stored in a WinSales database in another application (such as Excel).
To do so, export the data from WinSales into a text or ASCII file, then import it into the
other application.

Plan Your Export
Before building an export in WinSales, work through the following steps:

 Determine the attributes the other application expects in the text or ASCII file.
You'll need to know whether it accepts delimited or fixed ASCII files, the common
field and record separators, and whether or not it quotes around string values are
required.

 Determine which window(s) contain the data that you wish to use (include in the
export file, search, sort).

Define an Export
 Choose Workbench from the View menu.
 From the Use tab click, the + to the left of Export.
 Click [New Export] from the list.

The Criteria, Sort Order, and Fields tabs work the same as when building a query.

Example: Find Contacts in WA and CA, Sort by the Company Name, and include Fields:
Company Name, First, Last Name, Address1, City, State, Zip, Phone, and Sales Rep
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Export Options Tab
Click the Options tab.  The Options window allows you to specify the format of the export
file including:

Field Separator  The common character that separates one field from another.

Record Separator  The common character that separates one record from another.

Quotes Around String  Whether or not to include quotes around string values.

Include Headings  Include the field headings as the first record in the output file.

Apply Display Mask  Apply display masks in the output file.

Multiple Responses  WinSales only exports one value for multiple response type
fields unless this check box is selected.

Output File  The path and name of the ASCII file created.
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Save an Export
To save an export, click the SAVE button.  You are prompted for a name.  You may
either select an existing export to overwrite it, or type in a new name.  Once an export is
defined and saved, it appears under the list of existing exports on the Use tab.

Run an Export
 Click on the Results tab after creating a New Export

OR

 DOUBLE CLICK an existing Export from the list.

-Mass Assign

What is a Mass Assign -   With one click of a button a Mass Assign will initiate a
specific group of Contacts onto a selected Action Plan.  The Mass Assign is created in
the Workbench and when the results are found, the system will automatically Initiate the
Action Plan in the Contact Window, show a Scheduled Correspondence in the Activity
Window and show a Scheduled Correspondence in the Fulfillment Center.

Plan Your Mass Assign

 As with a Query, create a story problem in order to plan the Contact criteria you
will select.  Decide which Contacts and which Action Plan you are going to use.

 Create the Action Plan and Letters before you start the Mass Assign if it doesn’t
already exist.

Note:  You cannot view the results before the Action Plan is automatically
initiated.  To Mass Assign many contacts (1000's) to an Action Plan will create a
large number of activities.  It is always a good idea to build the Mass Assign as a
Query first so you can be sure all the records found are really the records you
want on the Action Plan.  This will help to ensure that all the Contacts are
initiated on the Plan in that the number of Query results found should equal the
number of Mass Assign results are assigned.
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Create A New Mass Assign

 Choose Workbench from the WinSales View Menu or press F4

Use Tab

 Click the + next to Mass
Assign and highlight [New
Mass Assign] in the list.

 Click the Criteria Tab.

Criteria Tab:  This works exactly the same as a Query, allowing you to use multiple
fields to select the records you wish to find.  Refer to “Create A New Query”.

In this example we selected all Contacts in the states of Washington and Georgia and will
assign them to the Intro-General Referral Action Plan.

Sort Order Tab:  You can order this any way you like since the results will not be
displayed.

Sort Order Tab  The selection you make does not matter since the results will not be viewed.

 Make a Sort Order selection then click the Options Tab
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Options Tab:  This is a list of all existing Action Plans.

 Highlight the Plan you want.  The first step of the Plan will default.  If you want a
different step, highlight that step.

 Click Results to Initiate the Mass Assign.

Results Tab:  The % bar on the bottom of the screen will display progress.  The
Message Window will indicate that the Mass Assign is complete by displaying the number
of Contacts assigned to the Plan.

When the Mass Assign is complete …

The Contact window shows that
the Action Plan has been initiated.
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The Activity Log shows a scheduled Correspondence Activity.

The Fulfillment Center shows the Scheduled Letters.
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Help Wizards

WinSales has created wizards to automate certain functions in your database.  It is a
good idea to consult with your WinSales Administrator before conducting any of these
functions, as the results may be irreversible.  A backup of the database is highly
recommended before proceeding with any of these functions in case a mistake is made.

Note: In order to use wizards you must have a security group called Admin in your
database.

Access Wizards
 From the WinSales menu choose

Tools then Wizards.
 Select Administrator or User

depending on the Security Group
you are in.

Run Wizards
 DOUBLE CLICK on a Wizard to launch the function.

Administrator Wizards
Delete Current Contact and its Activities – Removes all records for the Contact
currently showing in the Contact window.

Delete Multiple Contacts and their Activities– Allows you to select specific fields
on the Contact window and delete all Contacts with the selected criteria.

Mass Update – Allows you to find a group of records, select specific fields on any
window or table and change the value from one thing to another.  Example:  When a
Sales Rep leaves the company and a new one takes their place, update the Sales Rep
field on the Contact window to the new rep’s name. – OR – Change the date of a
scheduled Activity (such as a letter in Fulfillment) to a different date. – OR – If you import
a list of Contacts but choose the wrong Campaign, update the Campaign field with the
correct information.

Mass Delete – Allows you to find a group of records, select specific fields on any
window or table and delete the value in that field.

Note: This function will let you delete records without regard to other records in other
tables that may rely on the existence of the record.  For example, you can delete Contact
records, even if there are activities present for that contact. Use this feature with care.
Back up your database first!!!

Purge Old Activity Data– Delete all Activities for all Contacts in a selected date
range.

Contact Activity Summary– Totals the number of each Activity Type that has been
logged for the Contact currently showing in the Contact window.
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Other Wizards-
Delete All Activities For A Contact - Deletes all the Activities associated with the
Contact currently showing in the Contact window, but not the contact record itself.  This is
useful for managing mailing lists. You can remove the activity data but keep the Contact
record in your database so the record is not imported into WinSales and marketed to
again.

Update Action Plan Field On Contact - Enables users to find Contacts that are not
on an Action Plan.  The wizard prompts you to select a Relationship (or All), and will then
populate the Current AP field on the Contact window with the Action Plan name of each
plan the Contact is currently on.  If the Contact is not currently on an Action Plan the
value "None" will be populated as the Current AP.  Then you can search to find all
prospects that have a Current AP value of "None" and Mass Assign them to an Action
Plan (for example).

Export Activity Data By Campaign- Allows users to create a file for reporting
purposes that contains all the Activity information for Campaigns.  Then using Excel,
Crystal Reports, or other data manipulation tools users can format the data to their liking.
The wizard prompts you to select a Campaign (or All), then searches the database for all
Activity information for that Campaign and creates a CSV type file in
C:\WINSALES\DATA\CAMPEXP.CSV.  This file contains the Contact's ContactID,
Company Name, First Name, Last Name, the Activity Type, Date, Status, Campaign, and
Sales Rep.

Note: Remember the more data you ask WinSales to search for the longer this process
will take to run.  Searching for All Activity data for All Campaigns could take several hours
in a large database.

Reassign Contacts and Scheduled Activities - This feature allows you to reassign
the Contacts and scheduled Activities for a sales rep that is no longer with the company.
The wizard prompts you to select the Sales Rep whose Contacts and Activities you wish
to reassign, then asks for the Sales Rep you want to assign them to.  The wizard will then
update the Sales Rep field for all Contacts associated with the old Sales Rep, and
reassign them to the new Sales Rep. The wizard will then search the database for all
Activities associated with the old Sales Rep that have a Status of Scheduled, and
reassign them to the new Sales Rep you selected.  

When this process is complete the old Sales Rep's name will then be updated to "zJon
Doe" (for example).  This will put the name at the bottom of drop down lists referencing
the Sales Rep table.  Since it leaves all Activities with a Status of Resolved or Cancelled
intact with the z'd Sales Rep's name attached, you can still see that a Sales Rep who is
no longer with the company worked with a Contact in your database for a historical
perspective.

User Wizards
See Other Wizards above.
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Fulfillment Center

What It Does
The Fulfillment Center is where you can see all scheduled Correspondences in your
database that are cued to be merged and/or printed.  These include Action Plan
correspondence as well as manually scheduled items.  They may be email and automatic
faxes as well as printed letters, labels, postcards, greeting cards, newsletter, etc.

At any given time you may have many Contacts with scheduled Correspondence
Activities such as Action Plan steps and other scheduled items.  Rather than going into
each individual Contact’s Correspondence tab and printing each item individually, the
Fulfillment Center allows you do send and resolve them in mass from a central location.

Access Fulfillment Center
 From the WinSales Tools menu select Fulfillment Center.

OR

 DOUBLE CLICK the icon on your desktop

Log Into Fulfillment Program
 Log into the program by selecting your database and entering your User Name

and Password if you have one.



56

The Fulfillment Windows

Find Scheduled Letters –

This allows you to select which scheduled correspondences to view and send.

Through - The system default date is 7 days from today’s date.  You can enter any date
to view all scheduled correspondence through that date.

For - The system default is [All] but you can select a single name from the drop-down list
and view only that person’s scheduled correspondence.

 Select the date and Rep(s) you wish to view.
 Click OK.
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The next window displays the scheduled letter names on the left and the scheduled dates
across the top.  The grid shows the number of scheduled letters.

Sort By – This determines the order in which the documents will merge into Microsoft
Word.  By default, all documents merge in alphabetical order by the Contact merge fields
of Company, Last Name then First Name, whichever is listed first in the template.

In this example, the document will merge in
alphabetical order by Last name.

If Company was in the first line it would merge
in alphabetical order by Company Name.

If there were only a First Name it would merge
in alphabetical order by First Name

If there were only a Salutation or a Name field
after the word ‘Dear’, it would merge in
alphabetical order by that field.

Sales Rep is the default selection.  All of Janet’s letters will merge in a group,
then John’s, then Robert’s and so on.

Postal Code will merge in ascending numerical order by zip code.

Contact will merge in alphabetical order by the Contact fields in the template.
See ‘Sort By’ above.
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Print – The default is Letters.  This tells Word the path to the document to be merged.

Letters – Select an item in the grid and the letter path will display in the browser
field.

Envelopes/Labels – Select an item in the grid and press the browser button to
path to the correct document.

Number to Print or Reprint – This pertains to the item selected in the grid.

Yet to be Printed – Gives you the total number of selected items that have not
yet been Merged into Word.

Previously Printed -  Gives you the total number of selected items that have
already been Merged into Word.  The purpose of this feature is to avoid re-printing items
if you forget to Resolve them.

PLEASE NOTE THAT WINSALES CANNOT KNOW IF A LETTER WAS PHYSICALLY
PRINTED IN MICORSOFT WORD.  IT CAN ONLY KNOW THAT IT ALREADY MERGED
THE SELECTED ITEMS INTO WORD AND ASSUMES THAT YOU PRINTED THEM.

Select A Document To Merge
Microsoft Word can only merge one document template at a time so you must repeat this
process for each different document.

Single Day

 Click on the grid of the document you wish to merge into Word.
The selection is indicated by the dotted line around the grid.  The Yet To Be Printed box
will indicate the total of your selection.
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Multiple Days

Occasionally, you may have to send a document that is scheduled over multiple days at
the same time. You can merge them all at once by following the procedure below.

Note: If there is a date field in the document template all the letters will be dated
the same.  They will all have the same ‘Resolved’ date as well.

 Click the grid of the first day then hold and drag your mouse to the last day and
release.

Merge
When you press the button two things happen.

1.  WinSales copies the merge field information from each Contact record and inserts it in
the document.

2.  WinSales also takes note of the Method field of the scheduled Correspondence
Activity for each Contact.

If the Method is Mail, each record will merge into Word to be printed.

If the Method is Email, those Contacts with an email address will automatically
be emailed the document.  The remaining Contacts without email addresses will be
merged into Word to print.  See the section on setting up Email for this function.

If the Method is Fax, those Contacts with a fax number will automatically be
faxed the document.  The remaining Contacts without fax numbers will be merged into
Word to print.  See the section on setting up Faxes for this function.
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Balance
This special feature of the Fulfillment Center allows you spread a printing job over
multiple days.

Example:  When there is a large number of a document to print you may want to break it
up and do a portion of it over a 2 – 3 day period.  Or when a letter is part of an Action
Plan that, when Resolved, will schedule a large number of phone calls for a Rep, it can
be spread out over a longer period of time.  That will give the Rep time to keep up with
the calls.

 Highlight the grid you would like to Balance

 Click and hold your mouse then drag it to the right and release on the last date
you wish to print on.

 From the Options Menu select Balance
 If you do not have sufficient date columns to drag your mouse to, you must

modify the grid to insert columns.  See Insert Columns.

The letters will be evenly dispersed over the
number of days you highlighted.
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Insert Columns
When you don’t have sufficient columns to balance your letters with you must modify the
grid.

 Highlight the column you wish to add a column to.
 Select Grid from the menu bar and click Insert Column.

 Select the date you wish to add from the Calendar and press OK.
 Repeat until you have the desired number of date columns.

Resolve Fulfillment
Before you Resolve the Fulfillment Center, make sure all the documents printed correctly,
that you printed envelopes for your letters, etc.

 Select Options then Resolve
The message bar at the bottom of the window will display
progress.

WinSales will automatically update each Correspondence
Activity from a Status of Scheduled to Resolved.  For those
items that were a step of an Action Plan, WinSales will advance the Action Plan to the
next step.



62

Run Fulfillment
Now that you have read through the previous pages and understand the features and
functions of the Fulfillment Center, running it is pretty simple.

 Log into the Fulfillment Center and Find Scheduled Letters then click OK.
 Highlight the first document grid you are going to merge.
 Select the Sort By and the Print* option you want
 Load the printer with the correct paper, label or envelope for your selection.
 Click Merge to launch Microsoft Word or auto-send emails and faxes.
 Print* the Word documents.
 Repeat these steps for each document.
 Check the documents to make sure they printed correctly.
 Resolve when you are done.

*Reminder:  When you have letters with envelopes to print, don’t forget to do this step
for both of them.

Reprinting Letters
There are two ways to reprint letters.

Reprint in Fulfillment Center  -  Perhaps you printed on the wrong stationary, the
envelopes were upside down, your printer had a problem or the merge fields were wrong
and you had to make a correction to the document.  When you have to do the whole
batch again, this is the best way.  This can only be done BEFORE the letters have been
Resolved.

 Select the cells of the letters or envelopes/labels that have already been printed.
 Click on the Previously Printed check box.
 Click the Merge button and proceed as usual.

Reprint in the Correspondence Activity  -  When you only have to reprint a couple
of letters in a large batch, remerging the whole batch and then scrolling through it to find
the ones you need is too hard.  This can be done before or after Resolving Fulfillment.

 In WinSales, find the Contact’s Correspondence Activity for that letter.
 DOUBLE CLICK the letter icon adjacent to the letter field to launch Microsoft

Word.
 Print the letter or envelope and close Word.
 Resolve the Correspondence Activity or Resolve the Fulfillment Center if it is

still Scheduled.
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WinSales Administrator Program

The Administrator is the key to customizing WinSales to your specific needs.  It allows
you to change, delete or create Reference Tables and Activities.  The Administrator is
where you create the responses that appear in drop-down lists and masks that can be
applied to fields.  It is also where security can be set for Users, fields and tables.

• Create new Reference Tables and Activities.
• Customize existing fields and create new ones.
• Set up sites for remote synchronization.
• Set up database Users and their passwords.
• Set up security groups and establish security settings.
• Conduct database maintenance.

Access The Administrator

 You can place the Administrator icon on your desktop and double click it.
OR

 Press the Start button then select Programs – WinSales – Administrator.
OR

 From within the WinSales program menu bar select Tools – Administrator.

 Log into the Administrator program by selecting the database you wish to work in
then enter your name and password.
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Administrator Window

• The left-hand side of the Administrator window displays an alphabetical list of all
Activity types in the Activity window, Reference Tables in the Reference Material
window and the Contact window.

• The area on the right allows you to create new Reference Tables and Activities
and save them in the list.

• The function keys along the bottom of the window allow you to edit, delete and
save selected Tables and Activities.

• The File and Edit menu items allow for many other functions.

Security Groups

In order to add Users to the database you must assign them to a security group.  Your
database comes with three pre-defined groups that you can use or modify to your liking.

Admin: (Short for Administrator) This group has access to all functions of the WinSales,
Administrator and Fulfillment Center programs.

Public: This group has access to WinSales only.

Management: This group has access to WinSales and Fulfillment Center only.
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Create a New Security Group
To add New Users to your database you may want to create specific User Groups that
define which programs, tables, fields and functions certain people will be allowed to view
and/or work with.

Example:  Group A will only enter new Contacts and Schedule and Resolve
Activities. They will not be allowed to change certain fields or see certain Activity types
when they log into the database.  Whereas, group B will view and use all fields and
Activity types when they log into the database.

 From the Administrator menu, select Edit then
Security Groups.

 On the right side of the window, select New Group from the list.
 Type the name of the new group in the Name field on the left then press SAVE.

Your new group name will appear in the list of groups on the right.

Before you click the Done button to close this window, you should first grant
access to the functions you wish the new group to have.  See instructions under
Security Group Settings on the following pages.
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Security Group Settings
The Choices list shows functions to which access can be enabled or revoked.  Items with
a + adjacent to it contain sub-items.  To view the sub-items, click the + symbol.

Tip:  If there are sub-items you do not want a group to have access to, it is
faster to enable all items and then revoke those items they will not use.
See instructions to Revoke Access below.

Enable Access
 Highlight the group in the list on the right.
 From the Choices list, highlight the items you want one at a time then

press the left arrow button.  The items are copied into the Enabled list.
 When the list is complete press SAVE.
 Press DONE to close the window.

Revoke Access
 From the Enabled list, highlight the items you wish to revoke one at a

time then press the right arrow button.  The items are removed from the
list.

 When you are finished press SAVE.
 Press DONE to close the window.

Change Access
 In Administrator, select Security Groups from the Edit menu.
 Highlight the group to be changed in the list on the right.
 Make changes by following instructions to Enable or Revoke Access above.
 Press SAVE when finished.
 Press DONE to close the window.
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Delete A Security Group
 Choose Security Groups from the Edit menu.
 Select the name of the group to be removed from the list on the right.
 Choose the Delete button.
 A dialog box will display asking if you wish to proceed.  Press YES.
 Press DONE to close the window.
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Database User Sites

WinSales recognizes that databases may reside at different physical locations (sites).
This is important if synchronizing databases.  (Refer to the section on Remote
Synchronization).

The WinSales database provides one site, named Corporate that is pre-defined.  You
may wish to define additional sites, or rename this site, depending on your needs and
preferences.  Before adding a new site, and before altering the
Synchronization Rules for a site, please read the section on Remote
Synchronization.

Create A Site
 Log into the Administrator program and select Sites

from the Edit menu.

The Database Sites dialogue box displays.

 Highlight New Site in the window on the right and type a name in the Site
Name field on the left.

 If the new site resides in a different time zone than the master database used for
synchronizing, enter the number of hours difference, and choose Behind or
Ahead, to indicate the new site’s time relationship with the master database site.

 If the database currently opened is a Stand-Alone database, the Synchronization
Rules fields are disabled.  In this case, press Save.

 If the new site gets a synchronization extract from the database, check the Gets
Extract check box.

 If the database at this new site is to be a complete mirror image of the current
database, choose All Reps’ Info.  If the database at the new site is to contain
information pertinent only to users stations at the site, choose Rep-Specific
Info.
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Note:  Rep-Specific synchronizations take much longer to process than do full
(All Rep) synchronizations.  Carefully evaluate your need for re-specific sites.

 If the new site is to be a compete mirror image of the current database, and if the
new site’s database is to be a Master database, enter a Starting ID that is the
same as that of the current site (the site of the user of the current database.
(You may leave this field intact and edit it later, if you need to lookup the current
site’s Starting ID).  Otherwise, click the NEXT button.  WinSales generates a
number for use with the new site.

 Press Save.

Change A Site
 Choose Sites from the Edit menu.  The Database Sites dialogue box displays.
 Click the name of the site to be changed from the list on the right.
 Make changes, following instructions under Create A Site.
 Choose the SAVE button.

Delete A Site
 Choose Sites from the Edit menu.  The Database Sites dialogue box displays.
 Click the name of the site to be removed from the list on the right.
 Choose the DELETE button.

Database Users

Add New Users To Your Database
Adding database User names is done in the Administrator Program.  Instructions for
adding Users to a new database can be found in the User Manual.

 From WinSales select Tools on
the menu bar and click
Administator.

 Select the database you wish to add the
User to and log in as usually.
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Each WinSales database can be secured by establishing a list of Users that may access
the database.  Used in conjunction with Security Groups and Database Sites, the
functions each User can perform and the tables and fields each User can view and
modify in WinSales can be dictated.  See Security Groups and Database User Sites
covered previously in this section.

 From the Edit menu, choose Users.

 From the User List on the right select [New User].

Admin is the pre-programmed, generic User Name that allows you access to all
functions of the WinSales programs.  SP is the User Name that allows Silent Partner to
log into your program if you call for Technical Support and are not able to log in yourself
for some reason.

 Click in the User Name field and type the new User name.
 Enter a Password if you like although it is not required.
 If you are using a MAPI-compliant e-mail system, enter the User's E-mail

Address.

Note:  When connecting to this database, a User may enter their User name or
e-mail address.
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 Choose the Security Group to which this User will belong within the context of
your database.

Please read about Security Groups covered previously in this section.

 Choose the User Site the User will log into the majority of the time.
The database comes delivered with “Corporate” as the only choice but other sites can be
added.

Please read about Database User Sites covered previously in this section.

 Check the “Create a Sales Rep Record” box.
This will allow the User to log activities in the program.  If you don’t check this box you
will not be able to save activities for a Contact under the User’s name.

 If the new User is to be a member of a remote Synchronization site, highlight the
site in the Not member of Site list and press the left arrow.  The site name will
appear in the Member of Site list.  Please read the section on Remote
Synchronization in this manual.

 Press the SAVE button then press DONE to close the Administrator.
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Create New Activity and Reference Tables

Table Type
Before creating a new activity or reference table, it is important that you consider what
kind of information you wish to record or represent.

Activities can generally be thought of as events that can be scheduled and tracked.
Activities bring a Contact and a Sales Rep together at some point in time such as Phone
Calls, Correspondence and ToDo’s.

Reference tables are most likely a person, place or thing such as Sales Reps,
Campaigns and Marketing Details.

Table Outline – Fields and Elements
Once you have determined the table type, make a list of the information you want to
display in the activity or reference.  If you organize this information into specific data
elements, you now have a list of the fields to describe information that it represents, such
as a date, time, text or numeric.  To help organize and define your information, use
existing Activity and Reference tables in your database as guidelines.

Relationship/Link To Other Tables
Determine whether your new activity or reference table has any relationship with other
activities and/or reference tables.

Example:  The Campaign Reference Table is related to Contacts, the Marketing
Details Reference Table and several Activity Tables as indicated by the file tab symbols
in the illustration below.  The Phone Call Activity Table has fields related to Contacts
and Reference table items as indicated by the magnifying glass symbols.
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Create The Table
Step One

 Log into the Administrator program.
 Press the CLEAR button to be sure all fields are blank.
 Select the Type of Reference Table or Activity.
 Type the name of the new table in the Description field.
 Press the tab key on your keyboard and the Table Name field will display the

same name.  Change the name if you want it to appear differently on the window.
 For Activity Tables only, enter 3 letters in the Abbreviation field that will

appear in the Type column on the Activity Log.  Example:  The Phone Call
activity is Phn, Correspondence is Cor, etc.

 Trigger: DO NOT MAKE AN ENTRY OR SELECT ANYTHING FROM THE
DROP-DOWN LIST UNLESS A NEW TRIGGER HAS BEEN CREATED
SPECIFICALLY FOR THE NEW TABLE YOU ARE CREATING.  THIS FIELD
DISPLAYS TRIGGERS THAT HAVE BEEN ATTACHED TO THE EXISTING
ITEMS IN THE ACTIVITIES/TABLES LIST ON THE LEFT.

 For Activity Tables only, click the appropriate boxes adjacent to the items in
the Show Activities In list.  This allows the new Activity to display in the
Activity Log, and, when it is a status of Scheduled, in the Calendar’s appoint and
planner windows and the Task List.  Example:  Sale Activities display in the
Activity Log but not the Calendar or Task List.  However, Phone Call Activities
display in all three.

 When this window is complete, press SAVE and this message will display.
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Table Security
Grant Table Access
Step Two
Now that you have created the new Table you can choose which security group(s) to
grant the ability to see and use it when they log into the database.  If you do not grant
access to a security group they will not see the table when
they log into the database.

 From the Edit menu, select Table Security.
 In the Table Security window highlight a security group

in the list on the right.  (You can only choose one at a
time).

 In the Choices list, highlight your new table.
 Press the right arrow button to move it to the Enabled list.
 In the Allow box in the bottom left corner, uncheck the Inserts box if you do not

want the group to be able to make entries in the new table.  Uncheck the
Deletes box if you do not want the group to be able to delete entries in the new
table.

 Press SAVE.
 Repeat for each additional group.

Revoke Table Access
 From the Edit menu, select Table Security.
 In the Table Security window highlight a security group in the list on the right.

(You can only choose one at a time).
 In the Enabled list, highlight the appropriate table.
 Press the left arrow button to move it toward the Choices list.
 Press SAVE.
 Repeat for each additional group.
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Your new table will appear in the Activities/Tables list on the left.  To add fields to your
new table see the next section, “Table Fields”.

Delete A Table
 Highlight the table in the list, as shown above, then press the DELETE button.

Fields

Fields/Elements
Elements is the technical term for the fields within a table.

Create A New Field
 Log into the Administrator program.
 If already logged in, press the clear button to clear all fields.
 Highlight the Table you want to add fields to in the Activities/Tables list.
 Press the ELEMENTS button.
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When the selected table is an Activity, the window below will display.  The required fields
for all Activities have already been programmed and appear in the Elements list on the
left.  They are:  Contact name, Sales Rep, Campaign, Activity Date, Time and Status.

Element Type

There are three types of field elements.

Simple Field - These are basic fields that information is entered into.  Example: Email
field on the Contact window.

Reference to a Table - These fields are linked to a Reference Table and will appear
with the magnifying glass symbol in front of them.  Example:  Sales Rep field.

Display Text Only - These are not alphabetic fields.
Rather they are characters typically used to separate
sections of a window.  Example:  A dotted line as shown
here.

 Select the Type by clicking the circle adjacent to it.
 Press the DETAILS button.
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The Define a Field window will display.  This is where you make selections and entries for
the characteristics of the field.

 Type the name of the new field in the Description field and press Tab on your
keyboard to move to the next field.

 The Column Heading field will automatically display the Description name.
This is how the new field will display in the Table.

Note:  The column heading has two functions in WinSales.  When designing reports it is
the default column heading for this field and it is used by your word processor when
merging WinSales data into a form letter.  As such, it is necessary for you to choose a
column heading that is compliant with your word processor's field naming conventions.
Please refer to your word processor's documentation for additional information.

 Tab to the Data Type field and make a selection from the drop-down list.  This
tells WinSales what type of information belongs in the field so that the remaining
field characteristics can be determined correctly.   See The Data Types Chart
Appendix B.

Based on the selection made in the Data Type field:

The Maximum Size field will auto-populate with the correct number of characters
allowed.  The maximum is 65 characters.

The Mask field (how the data looks) may
populate a standard default format.  You can
enter a different format using the Mask chart at
the end of this section.  Example: If the Data
Type is “Date” the default Mask display will show a date of “7/4/2002”.  If you prefer the
display to be, “07/04/02” then change the Mask to “mm/dd/yy”.  See Mask Chart In
Appendix B.
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You may enter a Minimum Value and/or Maximum Value if it’s needed for the new
field.  Example:  If the field is a numeric data type, you may want a minimum value of
100 or $100.00 and maximum value of 100,000 or $100,000.00.  Entries above or below
those values would not be accepted in the field.

Default:  Whatever you type here with automatically display in your new field.

DO NOT make an entry or selection in the Trigger field unless a trigger has been
specifically built for this field.  If a trigger has been built, select the appropriate one.

Is Required:  If checked, WinSales will not
allow a record to be saved without first
entering something into the field.

Must be Unique:  If checked, WinSales will
not allow a record to be saved unless what is
entered in the field does not exist in any other
record in the table.  Commonly used for
account numbers, order numbers, etc.

Allow Custom Response:  This box is
checked by default so Users can make entries
into the new field.  For fields with a drop-down
list, check this box if you want to allow Users
to enter something that is not in the drop-down
list.
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Has Valid Response (Drop-down) List:  Check
this box to create a drop-down list for the field.  See
instructions below.

Create A Drop-Down List
 Before the Valid Response  button can be activated you MUST press the

SAVE button to save your new field name.

The Table Elements window will
display.

 Select your new field from the list on the left and press the DETAILS button.

  Check the Has Valid Response List box and click the  button to display the
Define Valid Responses window.

 Type the new item name in the Response: field on the right.
 NO NOT select a Trigger unless one has been built for you.
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 Click the SAVE button and your new item will appear in the list on the left.
 Repeat these two steps for each item you wish to add.  When finished, press

DONE.

Auto-Add Custom Responses:  For use only on
fields with a drop-down list when custom responses
are also permitted.  Checking this box causes any
entry typed by the User that is not already in the
drop-down list to be added to the drop-down list.

Allow Multiple Responses:  When checked,
WinSales allows the User to enter more than one
response into the field.  This creates the Multiple
Response  symbol adjacent to the field.   

Pre-determined Multiple Responses:  To
insert pre-determined responses in the Multiple
Response box, also check the “Has Valid Response
List” and follow the instructions for that choice.

Double clicking the multiple response field as shown
below will display the multiple response window
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Case Style-

As Entered-  This is the default choice.  When chosen, what
is entered in this field will display without modifications to the
case.  Example: This is a Test.

Logical Mix-  When chosen, what is entered in this field is
displayed with initial letters capitalized.  Example: This Is A
Test.

Uppercase-  When chosen, what is entered in this field is displayed in capital letters.
Example: THIS IS A TEST.

Lowercase-  When chosen, what is entered in this field is displayed in lowercase.
Example: this is a test.

Allow Edits

Entry-  When checked, WinSales allows Users to make an
entry in the field.  Also refer to FieldSecurity in this section.

Changes-  When checked, WinSales allows Users to make
changes to existing entries in this field.  Also refer to Field
Security in this seciton.

 When all selections have been made in the Define A Field window press the
DONE button.

A window will display telling you to grant access to your new field (elements) by selecting
Field Security from the Edit menu.  This works exactly the same at Table Security.
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Field Security

Grant Field Access
Now that you have created the new Field you can choose which security group(s) to
grant the ability to see and use it when they log into the database.  If you do not grant
access to a security group they will not see the table when they log
into the database.

 From the Edit menu, select Field Security.
 In the Field Security window highlight a security group in

the list on the right.  (You can only choose one at a time).
 In the Choices list, highlight your new field.
 Press the right arrow button to move it to the Enabled

list.
 In the Allow box in the bottom left corner, uncheck the

Inserts box if you do not want the group to be able to
make entries in the new field.  Uncheck the Deletes box if
you do not want the group to be able to delete entries in the new field.

 Press SAVE.
 Repeat for each additional group.

Note:  If the WinSales program was open when you created the new field, you
must close then re-open the program to see your new field.
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Modify A Field
To change any field in the database:

 In the Administrator program, select the Activity/Table the field resides in then
press the ELEMENTS button.

 Highlight the field in the Elements list then press the DETAILS button.

 In the Define A Field window change the field attributes as needed then press
SAVE.

If you change the name of a field the system will not prompt you to also change the Field
Security.

You may have to close out of WinSales then log back in to see your change.
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Modify/Delete/Add A Drop-Down List Item
To edit items in any drop-down list in WinSales

 In the Administrator program, select the Activity/Table the drop-down list field
resides in then press the ELEMENTS button.

 Highlight the field on the left then press the DETAILS button.

In the Define A Field window press the Has Valid Response button .

 Highlight the item in the Responses list on the left.  The item name will appear in
the Responses: field on the right.

 Press the DELETE button then the SAVE button to delete the item.
 Type a new item name in the Response: field to modify it then press the SAVE

button.
 From a Clear window type a new item to add to the list then press SAVE.
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Database Maintenance

Your WinSales database is a Microsoft Access database with a file extension of *.WSD
(WinSales Database) that needs regular maintenance like all Microsoft Access databases
do.  If you do not perform these functions you run the risk of permanently corrupting your
database to a point beyond repair.  When your WinSales database requires
maintenance, it will no longer let a user log in until the database has been Optimized.
Database maintenance takes more time the larger your database file becomes.

Regular Backups
On a regular basis you should create backups of your database.  The frequency depends
on the volume of changes to your database.  Daily backups are recommended, though
you should also create interval backups where you have a backup of the database once
a week going back two months (for example).  Many customers use tape backup systems
to run the WinSales database on to tape for these purposes.  Talk to your IS department
about what backups are already in place in your systems.

Special Backups
Prior to any major change to your database (importing a large number of records, mass
assigning contacts to an action plan, etc.), create a special backup so that you can
restore if anything goes wrong.  You can do this quite simply by opening Windows
Explorer and selecting your WSD file, then use the Windows commands to Copy &
Paste.  This  will create a "Copy Of XYZ.WSD" file in the same directory.  This is an ideal
method of making a quick safety backups as you can do this while users are logged into
the WinSales database.

Optimize The Database
Optimizing is the process of rebuilding the sorted indexes in the Microsoft Access
database.  These indexes are used to maintain relationships between tables within your
database.  You should optimize your database regularly; once a week is recommended.
All users must be logged out of the database during optimization.  Your database takes
longer to optimize the larger it gets.  Launching the optimization on a faster machine, or
from the server itself, also makes a big difference in performance.

 Start the WinSales Administrator.
 At the Connect to Database window, click CANCEL.
 Choose Optimize from the File menu.
 Enter the database, user name, and password.
 When finished click DONE to close the WinSales Administrator.
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Compact The Database
Compacting is the process of removing records that have been flagged for deletion in the
database.  You should compact your database regularly; once a month is recommended.
Be sure to optimize your database before compacting, but realize you do not need to
compact each time you optimize.  All users must be logged out of the database while the
compact runs.

 Start the WinSales Administrator and log into the database that  you want to
compact.

 Choose Compact from the File menu.
 When you compact, WinSales makes a complete copy of the database in the

same path as the database.  Over time these files will build up and use free disk
space.  Be sure to go through and delete the old compacted copies of the
database occasionally.

Note: Be sure the machine housing the database as well as the machine where you are
running the compact from, has plenty of free disk space.  Compacting a database without
at least two times the size of the database in free space can potentially corrupt a
Microsoft Access database.

The database LOG file
When you optimize or compact your database through the WinSales Administrator a LOG
file is created in the path of the database file.  The LOG file will be the same name as the
WSD file, and will be appended to each time a Optimize or Compact is run.  For example
if your file was XYZ.WSD, you would have a XYZ.LOG file in your database path that was
a history of every time you ran the Optimize or Compact functions.  Your log file should
look something like the below.

03-30-2000    13:56:34      Optimize started.
03-30-2000    13:57:33      ReIndexing started.
03-30-2000    13:57:34      ReIndexing completed.
03-30-2000    13:57:34      Optimize complete.
03-30-2000    18:14:23      Compact started.
03-30-2000    18:15:27      Compact completed.
03-30-2000    18:15:28      ReIndexing started.
03-30-2000    18:15:28      ReIndexing completed.

If the WinSales Administrator is not completing, or giving errors during an optimize or
compact look in the LOG file as the specific tables in the database that are causing
problems will be listed.  This can be helpful when troubleshooting how to fix a damaged
database.
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Remote Synchronization
Remote Synchronization permits two or more WinSales databases to periodically
exchange data with one another.  This allows users at different sites to work
independently, yet permits composite analysis and reporting from a master database.  A
user can synchronize between home and office.  Instead of transferring the entire
database when going home for the night, create a synchronization file containing the
day's changes.

On a local area network (LAN), synchronize between groups of users.  If there are groups
or departments within your organization that work fairly independently, or generally work
with different accounts, giving each such group its own WinSales database can have
performance advantages.  By periodically merging all data into a master database,
composite reporting and analysis can be performed.

People on the go can synchronize between their portable computer and the office
database.  Before going on the road, synchronize the central corporate database and
your notebook computer.  While on the road, continue working with WinSales as you
normally would.  When you return to the office, merge your changes back into the office
database.  Or, while on the road, dial in via modem to retrieve updates from corporate,
and transmit your changes through RAS or a MAPI complain email system like Microsoft
Outlook.

Field Reps can synchronize via modem with the central office.  Each day, or weekly, field
reps can dial in via modem and transmit their changes to corporate.  Changes from
corporate are retrieved and merged into the field rep's database, keeping everyone
current.  Branch Offices can synchronize with the central office, as well as with their own
Field Reps.  A multi-tier network can be established by having corporate synchronize with
a regional office, and the regional office synchronize with its reps in the field.
Manufacturers can synchronize with distributors.  When manufacturers get leads, they
often send those leads to distributors, resellers, or dealers throughout the country.  With
everyone using WinSales, the leads can be automatically communicated to the proper
parties, and updated information can be passed back from these remote sites.

In this section you will learn to design a synchronization plan and set up a new site.
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Design A Synchronization Plan
It is important to understand the relationship between different sites, databases and users
before setting up your synchronization facility.

Mechanisms for Transmitting Data
There are three distinct ways for sites to exchange information; floppy disk, modem, and
network.  The connection between two PCs in any of the configurations discussed here
can be any of these three techniques.  In an installation with many PCs, any combination
of the three transmission techniques can be used freely.

Synchronizing via floppy disk has distinct advantages in many environments.  Offices
without a network can periodically synchronize data on multiple PCs.  A single user can
synchronize home and office PCs.  Corporate headquarters can distribute new leads to
distributors, resellers, regional offices or traveling reps.  Two remote reps can
synchronize between themselves without the need to connect their PCs.  PCs without a
modem can synchronize with others.

In this scenario, one PC user extracts database changes onto a floppy disk and gives this
disk to another PC user.  The second user imports these changes from the floppy disk
into his database.  The process is repeated in reverse to make the two databases match.

Modem is the fastest way to communicate for most remote sites.  Traveling reps can call
from the hotel room to synchronize.  Regional offices call corporate headquarters daily to
synchronize.  Two remote reps can synchronize between themselves.

Using the modem, one PC user extracts database changes into a file on his hard drive,
uses a communications program to call in to the other PC, transmits the file, loads any
file(s) waiting for him, then uploads such files into his database.
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Portable computer users that connect to the network while in the office, but continue to
use WinSales while on the road, can use either of the above techniques to synchronize,
but will also often use the network connection (when back in the office) to facilitate
synchronization.  The benefit of using the network connection is speed.

Using this technique, a portable computer user, on the network, would synchronize just
before leaving the office.  Back from being on the road, this user reconnects to the
network and re-synchronizes.

Another use of network synchronization is to gain significant performance advantages.
Networked sites could elect to have a synchronized WinSales database on each user's
PC, synchronizing periodically throughout the day.  Because each user has his own local
database, there is no performance degradation normally experienced when transmitting
data across a network, and when sharing a database with other users.
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Synchronization Architecture

Hub and Spoke
The most common architecture is the hub-and-spoke concept, where one PC (generally
the corporate file server) contains a master database containing all WinSales data, and
one or more remote PCs communicate with the central PC.  The advantage of hub-and-
spoke is that remote sites are not dependent on the availability of another remote site's
PC, or whether another remote site has up-to-date data from other sources.  One
potential disadvantage to the hub-and-spoke concept is that a bottleneck could arise
when several remote sites try to communicate with the central PC at the same time.  This
drawback can be overcome by installing additional modems at the hub.

In the diagram above, F is a central PC (the hub).  Each remote site (A through E)
communicates only with the hub to be brought up-to-date.  For example, each evening
each remote site transmits its changes to the hub.  Each morning each remote site
retrieves updates from the hub.

Database Styles
There are three styles of database; stand-alone, master, and remote.  Within the context
of synchronization, databases are either master or remote.  The appropriate style for a
database depends on the intended purpose of the synchronization, and which component
of the architecture the database represents.

Generally, there is one master database and one or more remote databases.  A master
database contains all information, and each remote can either contain a complete mirror
of that information, or a portion of the overall information, referred to as rep-specific.

Note  Rep-specific synchronization's are much slower than a full (all-rep)
synchronization.

Master database users (security permitting) can alter the structure of the database, using
WinSales Administrator.  New screens, reference tables, and activities can be designed,
fields can be changed, and drop-down lists maintained.  Remote database users cannot
use WinSales Administrator to alter the definition of the database, nor to establish new
sites, users, or groups.  All such maintenance must occur at the master database site
(such changes are communicated to the remote sites via the synchronization function).
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Fields that have a drop-down valid response list, where custom responses are also
permitted, and where such a custom response is automatically added to the list, function
differently at the remote sites.  Such a field will not permit a custom entry at remote sites.
If it is necessary to permit a custom response for such a field, you'll need to disable the
auto-add feature for the field.

Design The Synchronization Configuration
Refer to the model configurations in the preceding section, and choose the model that
best describes your installation.  On a piece of paper, draw a complete configuration, with
a box drawn for each remote site to be included.  Next to each box, list the names of
users that will be based at that site.  The site that will house the master database need
not have a list of users.

The above diagram is an example of how to map out your installation.  This example is a
distributed hub and spoke configuration.
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Set Up The Master Database For Sync

The first step in building a synchronization facility is to establish a database as the master
database.  These instructions assume that you have already set up a database that will
become your master database.

 Start the WinSales Administrator.
 Open the database that you intend to make the master database.
 From the Edit menu, choose Database Settings (ALT, E, D).
 The Database Settings dialogue displays.
 Choose a Database Style of Master and click the Save button.
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Set Up Remote Synchronization Sites
The next step in defining a synchronization is to establish the list of sites.  A site is any
location that will contain its own database file.  A site may be someone's portable
computer or it may be another office.

 To create a site choose Sites from the Edit menu. The Database Sites window
displays.

 From the list, choose [New Site].
 In the Name field enter a unique name for the new site.

If the new site resides in a different time zone from the master database, enter the
number of hours difference, and choose Behind or Ahead, to indicate the new site's time
relationship with the master database site.  For example, if the master database resides
in Seattle and your new site is in New York, the new site is three hours ahead of Seattle.

 Make sure the Gets Extract check box is selected.

If the database at this new site is to be a complete mirror image of the current database,
choose All Reps' Info.  If the database at this new site is to contain information pertinent
only to users stationed at the site, choose Rep-Specific Info.

 Enter a four character Short Name for this site (the users initials + DB work well).
 WinSales automatically generates a Starting ID number for use with the new site.
 Choose the Save button.

Repeat these steps for each site you wish to create. After you have finished creating all
the sites, you will need to create new databases for these sites.
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Creating New Databases

Each WinSales database is a separate, independent file.  If you want to create a new
WinSales database, choose New from the File menu.

Name  Assign a name to the new database.  This name appears on the drop-down list
on the Connect to Database window.

Site  The site associated with this database.

Modeled After  Select a database from the drop-down list.

Database File  The name of the physical database.

Add Name to List   May optionally be checked to add the database to the Connect to
Database drop-down list when logging into WinSales.

Synchronize With Model   Must be checked if this database is intended for use at a
remote site.

 Click OK and WinSales creates the new database.

NOTE: Rep-Specific synchronization sites take much longer to process then all-
rep sites.  Carefully evaluate your need for rep-specific sites in remote
synchronization.
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Remote Sync Using The Administrator

For the Master Site  The master site always imports the sync file from remote sites
and then does an extract to redistribute those changes.

Importing
 Open the WinSales Administrator and log in as yourself.
 Choose Synchronize from the File menu and select Import.
 Click on the Standard Extract Files option.
 Click OK to start the import.

This will import all of the extract files in your SyncPath that belong to the master
database.

Extracting
 Go into the WinSales Administrator.
 Choose Synchronize from the File menu and select Extract.
 Click OK.
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WARNING: If the sync file already exists you will receive a message asking if you wish
to append or replace the existing sync file.  Appending will add any new changes to the
existing file.  Choosing replace will cause the existing sync file to be overwritten.  Once
the Extract is complete click Cancel on the Synchronize Extract window.

For the Remote Sites: Remote sites always perform an extract before importing.

 Open the WinSales Administrator and log in as yourself.
 Choose Synchronize from the File menu and select Extract.
 Click OK to create the sync file in c:\winsales\sync\

WARNING: If the sync file already exists you will receive a message asking if you wish
to append or replace the existing sync file.  Appending will add any new changes to the
existing file.  Choosing replace will cause the existing sync file to be overwritten.  Once
the Extract is complete click Cancel on the Synchronize Extract window.

Importing
 Now choose Synchronize from the File menu and select Import.
 Click on the Standard Extract option and OK for WinSales to look for sync file in

the users SyncPath, or select Other File and browse to the WSX file.
 Click OK to start the import.

 Once the import is complete click Cancel on the Synchronization Import window.
 Close the WinSales Administrator program by clicking the Done button.
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Step By Step Instructions To Set Up Remote Sync

Step 1 - Setting Up Remote Synchronization

 Log into the master database in the WinSales Administrator.
 At the Connect to Database window enter a User at the corporate site who is in

the ADMIN security group.
 Once in the Administrator select Database Settings.
 Verify the Database Style is a Master. (If it’s not, select Master and Save click).

 The first time you create a remote site you will need to make the database a style
of Master.  Once the database is made a master there is no need to repeat this
step.  Proceed to Step 2.
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Step 2. Creating The Remote Database Site.
If you are recreating a database's site, you may proceed to Step 4.

 In the Administrator Select the Edit Menu.
 Under the Edit menu
 Choose Sites.

 If the site does not exist, follow the directions below.
 Proceed to Step 4 if recreating a database for an existing site.

 Choose New Site and type in the Site Name.
 Clock Offset refers to how many hours ahead or behind from the master

database.
 Select the appropriate Sync Option.
 Enter a four character Short Name.
 Save any Changes.
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Step 3. Verify the User is linked to the correct site.
 Under the Edit menu Choose Users.
 Verify that the user is associated with the correct Security Group (Remote

Admin).
 Also be sure the user is linked to the appropriate User Site.

Step 4. Creating the Remote Database
 In the WinSales Administrator select New from the File Menu.
 Enter a Name of 8 characters or

less.
 Select the site you are creating in

the For Use At Site list.
 Choose the master database from

the Modeled After list.
 The Database File window fills in

automatically.
 DO NOT check Add Name to List.
 Select Synchronize with Model.
 Click the OK button and the

database will be created.

NOTE: You must have exclusive use of the master database when creating
remote sites!!!
NOTE: Creating a database for a Rep-Specific remote site takes much longer
then a All-Rep style site.   Always create a remote site at the fastest machine
available, and for increased performance bring the master database file local to
the machine and create the new remote database on the local machine.  Don't
forget to check your Free Disk Space before creating a new database!!
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Step 5.  Connecting To The Database.
 Move the database onto the machine where it will be used by copying the

database file (with an extension of *.wsd) to the machine's c:\winsales\data\
directory.

 Start WinSales on the machine where the database will be used.
 At the Connect To Database window enter a new name.
 Check the Add Name To List box.

 Navigate to the database file and click OK to connect.

In the future when logging into WinSales the database name you typed in will show up in
the Connect To Database drop down list with the user name defaulting to who last logged
in.
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Using NetSync To Automate Remote Synchronization

NetSync is a licensable feature of WinSales that allows users to automate running
synchronization so that users do not have to go through the WinSales Administrator to
run sync.  NetSync can be setup to run automatically at certain times in the day, or to
have sync files sent through MAPI compliant email systems.

For NON-MAPI NetSync

At the Master Site
 You should have one machine where you run the NetSync program.
 A user will be set up for running NetSync for the master database.
 To start NetSync double click on the icon on the desktop.
 In most cases a command line is set up to run the program in a predefined

fashion.  If the Command Line is not in place you can create the Command Line
using the documentation available on Command Lines.

NetSync will import any synchronization files from remote sites that are in the SyncPath.
Then NetSync will create the synchronization Extract files for all the remote sites in the
SyncPath.

Remote Synchronization Instructions For NON-MAPI NetSync

At the Remote Site
 You should have one machine where you run the NetSync program.
 A user will be set up for running NetSync.
 To start NetSync double click on the icon on the desktop.
 In most cases a command line is set up to run the program in a predefined

fashion.  If the Command Line is not in place you can create the Command Line
using the documentation available from Silent Partner.

 NetSync will create the synchronization extract file to go to the master site.
Then NetSync will import the synchronization file from the master site for this
remote that is located in the SyncPath.
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For MAPI NetSync

At the Master Site
 You should have one machine where you run the NetSync program.
 A user will be set up for running NetSync for the master database.
 Log into the email system and select Deliver Now from the Tools menu.  The

user running NetSync on the master will see in their Inbox the emails from
various remote sites.  Each email has an attachment of a WinSales
Synchronization file.

 To start NetSync double click on the icon on the desktop.
 In most cases a command line is set up to run the program in a predefined

fashion.  If the Command Line is not in place you can create the Command Line
using the documentation available on Command Lines.

 NetSync will import any synchronization files from remote sites that are in the
Inbox.  Then NetSync will create the synchronization extract files for all the
remote sites and they will be in the Outbox.

At the Remote Site
 You should have one machine where you run the NetSync program.
 A user will be set up for running NetSync.
 Log into the email system and select Deliver Now from the Tools menu.
 The user running NetSync on the remote will see in their Inbox the email from the

master site.  Each email has an attachment of a WinSales Synchronization
Extract file.  It is ok if there's more then one.

 
 To start NetSync double click on the icon on the desktop.
 In most cases a command line is set up to run the program in a predefined

fashion.  If the Command Line is not in place you can one using the
documentation available on Command Lines below.

 
 NetSync will create the synchronization extract file to go to the master site.

Then NetSync will import any synchronization files from the master site that are
in the Inbox.  Once NetSync has run the emails will be gone from the users
Inbox and a new email should be seen in the Sent Mail with an extract file
attached and addressed to the master site.
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Automating NetSync Using Command Lines

Setting up the Shortcut to NetSync
 Create a shortcut on the desktop to the wssync.exe file located in C:\winsales\.
 Once the shortcut is created, right click on the icon and select Properties.
 Choose the Shortcut tab and use the Target as instructed below to build your

command line.

Pre-defined Settings
You may pre-define the database, user and interval used by the NetSync program when
running synchronization.  In the Target the Command Line will include the name of the
program file, followed by one or more of the parameters described below.  A very basic
command line is:

c:\winsales\wssync.exe /db=c:\winsales\data\demo.wsd /user=Admin

This will run NetSync as the Admin user on the Demo database, using the Admin user's
User Settings to decide where the SyncPath is, and any email settings for that may apply
for running sync as that user.

/db=name The name of the database file.  This is a fully qualified file and
path name.

/user=name The name of a WinSales user authorized to do sync's for the
database.

/interval=n The number of minutes, hours or days between synchronization runs.
Place the letter "m", "h" or "d" after the number, to indicate minutes, hours or days,
respectively.  Zero causes NetSync to execute once, then the program displays the
screen log waiting for user to exit.

/exit When present, NetSync terminates after execution.  Can be used only when a
zero interval is specified, or when no interval switch is present.

/minutes=n1,n2... List of minute numbers in which NetSync may execute.  If not
specified, NetSync will execute in any minute of the hour.  Minutes are specified as 0
through 59.  More than one minute may be specified by separating each with a comma.
No spaces are permitted in the list.

/hours=n1,n2... List of hour numbers in which NetSync may execute.  If not specified,
NetSync will execute in any hour of the day.  Hours are specified as 0 through 23.  More
than one hour may be specified by separating each with a comma.  No spaces are
permitted in the list.

/days=n1,n2... List of day numbers or weekday abbreviations (or a combination of the
two) on which NetSync may execute.  If not specified, NetSync will execute on any day.
Day numbers are specified as 1 through 31.  Weekday abbreviations are specified as
Sun through Sat.  More than one day may be specified by separating each with a
comma.  No spaces are permitted in the list.
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/wait If present, NetSync does not execute immediately when the program starts, but
instead waits according to /interval, /hours and /minutes.

Example 1:

c:\winsales\wssync.exe /db=c:\winsales\data\demo.wsd /user=Admin
/interval=30m

This example conducts synchronization for the demo.wsd database, located in the
c:\winsales\data path, every 30 minutes.  The user named "Admin" is tied to the remote
sync site that this database represents, and is authorized to perform synchronization’s for
this database.  The first sync will occur immediately when the program is started.

Example 2:

c:\winsales\wssync.exe /db=c:\winsales\data\demo.wsd /user=Admin
/interval=1h /hours=9,10,11,12,13,14,15,16,17,18 /days=Tue,Thu, /minutes=0
/wait

This example conducts synchronization’s for the demo.wsd database, located in
the c:\winsales\data path, every hour, at the top of the hour (minute 0), but only
from 9:00am through 6:00pm (18:00 hours), and only on Tuesdays, Thursdays or
on the first of the month.  The user "Admin" is tied to the remote sync "site" that
this database represents, and is authorized to perform synchronization’s for this
database.  The first sync will not occur immediately when the program is started,
but when the top of the next hour occurs within the hours listed.
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Appendix A

Things You Can Do To Break Your WinSales Database

Using WinSales and the WinSales Administrator you can cause great harm to your
database by deleting items that are needed for the database to run properly.  Here is a
list of items that we have identified that can cause harm to your database.

 Do not remove [Other] from the Enclosures field drop down list
 Do not remove all documents from the Letters field drop down list
 Do not remove the House Sales Rep until you have another Sales Rep defined.
 Do not remove the General Campaign until you have another Campaign defined
 Do not remove any items from the Next Step fields drop down lists.
 Do not add any Next Steps
 Do not remove ALL entries in a drop down list for a field that is part of a wizard.
 Do not remove the Setup reference table
 Do not remove the Profile 1 in the set up reference table
 Do not remove the States reference table
 Do not remove any states from the State reference table
 Do not remove the Area code reference table
 Do not remove the Admin user
 Do not remove the SP user
 Do not remove all Delete Reasons ( leave at least 1 that can be changed)
 Do not remove any Activity tabs
 Do not rename any fields on Contact or Activities
 Do not remove any fields on Contact or Activities
 Do not disallow Field Security to any fields on any tab including Contact
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Appendix B

Data Type Chart  
The type of data that is permitted in this field.  Valid data types are:

Data Type Description
Text Any characters that can be typed on the keyboard.
Numeric Any numeric expression, including the digits 0 through 9, dollar

sign ( $ ), comma ( , ), decimal point ( . ), parentheses ( ) and
hyphen ( - ).

Date Any date between January 1, 1753 and December 31, 2078,
inclusive.  Dates can normally be entered in any of the
following formats, but your Windows international settings
may alter these:
3/29/93, 3/29/1993, 3-29-93, 3-29-1993, March 29,1993, Mar
29, 1993, 29-Mar-1993, and 29 March 93.

Time Any time expressed in either the 12 hour or 24 hour clock
format.  For accuracy, 12 hour clock times should include AM
or PM, otherwise AM is assumed.  Time can normally be
entered in any of the following formats, but your Windows
international settings may alter these:
08:32 PM, 8:32 PM, 20:32, 08:32:23

Duration When logging an activity via New+Perform Now, a duration
field will automatically be computed as the time it took to
complete the activity.  Duration can be modified once a record
is saved, using one of these formats:
01:22:13, 1:22:13, 15:42, 00:15:42

Yes/No A field of this data type appears in WinSales as a drop down list
with two choices: Yes and No.

FormLetter Any valid file name including optional path (the directory
referenced in the Options+Settings: "Form Letter Path" is
assumed).  Form Letter fields appear in WinSales with an
adjacent form letter icon, that, when DOUBLE CLICKED,
launches your word processor and opens the file specified.

Status A field of this data type appears in WinSales as a drop down list
containing Resolved, Canceled and Scheduled.  For internal
WinSales use only; you may not choose this item.

Time Stamp A time stamp field is automatically computed when a record is
added, and includes both date and time.

ID Every record stored in any WinSales table is assigned a unique
ID number.  Including a field of this data type in a table
provides visibility to this number.  An ID field's contents may
never be modified by the user.

Credit Card When data is entered into a field with this data type, WinSales
ensures that the number entered conforms to the modulo-10
credit card check digit algorithm.  The entry is re-formatted
with properly-inserted hyphens depending on the type of credit
card.

OLE Object Inclusion of a field with this data type provide a user to attach
an OLE object to a record by DOUBLE CLICKING the OLE
icon adjacent to the field.
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Mask Chart
A mask is comprised of a series of symbols that determine how data in the field is to be
formatted for display.

Symbol Meaning
0 Digit place holder.  If the number has fewer digits than there are

zeroes, on either side of the decimal point, leading or trailing zeroes
are inserted.  Extra digits following the decimal point are truncated.
Extra digits before the decimal point are included.

# Digit place holder.  Same as 0, except leading and trailing zeroes are
not inserted if the number has fewer digits than there are #'s.

% Percentage place holder.  The number is multiplied by 100 and the %
character is inserted where it appears in the mask.

, Thousand separator.  Group 0's and #'s before decimal point in groups
of three using the comma.  The actual character used is determined by
WIN.INI's sThousand= parameter.

: Time separator.  Use to separate hours, minutes and seconds.  The
actual character used is determined by WIN.INI's sTime= parameter.

/ Date separator.  Use to separate day, month and year when dates are
being formatted.  The actual character used is determined by
WIN.INI's sDate= parameter.

-+$( ) Display literal character.  To display characters other than these,
precede each with a \ or enclose in quotation marks ( " ).

\ Display the next character as a literal.

A mask for formatting numbers can have from one to three sections, each separated by a
semicolon ( ; ) as follows:

If you use: The result is:
One section The mask applies to all numbers.
Two sections The first section applies to positive numbers, the second to

negative numbers.
Three sections The first section applied to positive numbers, the second to

negative numbers and the third to zeros.
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A
Action Plan

fulfillment center, 61
update a/p field, 54

Activities
reassign, 54

Activity
summary, 53

Activity Tab
new, 72

Administrator Program
log in, 63

C
Contacts

reassign, 54

D
Database

sites, 68
Date Range

query, 40, 41
Delete

all activities, 54
contacts & activities, 53
mass delete, 53
tables, 75

Drop-Down List
create new, 79
delete item, 84
modify, 84

E
Elements

definition, 75
Export

activity data by campaign, 54

F
Field

allow edits, 81
auto-add custom response, 80
case style, 81
column heading, 77
custom response, 78
data type, 77

data type chart, 106
default, 78
drop-down list, 79
field type, 76
masks, 77
maximum size, 77
min/max value, 78
multiple responses, 80
new, 75
required, 78
security, 82
unique, 78
valid response, 79

Fields
modify fields, 83

Fulfillment Center
definition, 55

M
Mask

chart, 107
Mass Delete, 53
Mass Update, 53
Modify

fields, 83
Multiple Response

create new field, 80

P
Purge

old activity data, 53

R
Reassign

contacts and scheduled activities,
54

Reference Tab
new, 72

Resolve
fulfillment center, 61

S
Security Groups

change access, 66
create new, 65
definition, 64
delete, 67
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enable access, 66
revoke access, 66
settings, 66

Sites
change, 69
delete, 69
new user site, 68

T
Table

access, 74
create new, 72

U
Update

mass update, 53
Users

add new, 69
new, 69
security, 71


